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Branch Transformation Toolkit installation guide

This installation guide describes the hardware and software requirements of
version 5.1 of IBM® Branch Transformation Toolkit for WebSphere® Studio and
how to install it into WebSphere Studio Application Developer or WebSphere
Studio Application Developer Integration Edition so that you can develop
applications. For information on installing the sample applications provided in the
Branch Transformation Toolkit, see the deployment procedures of the HTML
Sample and Java™ Sample.

This document is for anyone who is installing version 5.1 of IBM Branch
Transformation Toolkit for WebSphere Studio and describes how to install it into
WebSphere Studio Application Developer or WebSphere Studio Application
Developer Integration Edition.

Typographic conventions

The installation guide uses the following typographic conventions:

Convention Description of convention

Bold Used to indicate something you select or
click in the GUI

Italics Used for emphasis or to refer to another
document

Monospace font Used to indicate text that you type yourself

Oor screen messages

<> Used to enclose descriptions of variables
that you must type yourself or names of
tags within XML files as shown in the
following examples:

e <variable name>

* <tag name>

Keys are identified in this guide just as they appear on the keyboard (for example,
Enter, Tab, Ctrl).

Hardware and software requirements

This section lists the hardware and software requirements for the runtime and
development environments of IBM Branch Transformation Toolkit for WebSphere
Studio (Branch Transformation Toolkit) 5.1.

The Branch Transformation Toolkit 5.1 supports the following platforms:
*+ Microsoft® Windows® 2000

— Microsoft Windows 2000 Professional with Service Pack 4

— Microsoft Windows 2000 Server with Service Pack 4

— Microsoft Windows 2000 Advanced Server with Service Pack 4
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¢ Microsoft Windows XP

— Microsoft Windows XP Professional with Service Pack 1la

* Microsoft Windows Server 2003

— Microsoft Windows Server 2003, Standard
— Microsoft Windows Server 2003, Enterprise

e Sun Solaris

— Sun Solaris 8 with the Recommended Patch Cluster of November 2003
— Sun Solaris 9 with the Recommended Patch Cluster of November 2003

+ Red Hat Linux® on Intel®
— RedHat Linux v7.2
— RedHat Linux v8.0
— RedHat Linux v9.0

- Red Hat Enterprise Linux WS 3.0 Update 1 or 3
— Red Hat Enterprise Linux AS 3.0 Update 1 or 3
— Red Hat Enterprise Linux ES 3.0 Update 1 or 3

« IBM AIX®

AIX Version 5.1 with the 5100-05

AIX Version 5.2 with the 5200-01 recommended maintenance package and
APAR 1Y44183, and PTF U484272

— AIX Version 5.2 with 5200-03 recommended maintenance package
- AIX 5L" version 5.3 with Websphere Application Server APAR PK01428

« IBM z/0S

— IBM z/0S® 1.2 or later

Microsoft Windows 2000 requirements

The following tables list the requirements for Windows 2000.

Table 1. Client

Windows 2000 client

Requirement

Processor PII 266 MHz or higher

Memory 48 MB minimum /64 MB recommended
Hard drive 50 MB

Display 800 x 600 minimum / 1024 x 768

recommended

Intranet test LAN base

16 MB token ring / 100 MB BaseTx Ethernet
recommended

Operating system

Microsoft Windows 2000 Professional with
Service Pack 4

Browser

Any of the following:

* Netscape Communicator 7.02 or later with
Java Plug-in 1.3.1 or later

* Internet Explorer 6.0 SP1

Communication protocol

TCP/IP

JDK

Java 2 SDK supplied by WebSphere
Application Server
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Table 2. Server

Windows 2000 server

Requirement

Processor PII 500 MHz or higher
Hard drive 100 MB minimum
Memory 512 MB minimum / 768 MB recommended

Operating system

One of the following:
* Microsoft Windows 2000 Advanced Server
with Service Pack 4

e Microsoft Windows 2000 Server with
Service Pack 4

Application server

One of the following required:

+ IBM WebSphere Application Server V5.1.1

* IBM WebSphere Application Server
Network Deployment V5.1.1

* IBM WebSphere Business Integration
Server Foundation V5.1.1

Communication protocol

TCP/IP

Communication services (LU0, LU6.2)

IBM Communications Server V6.1.2

Database manager

One of the following:

« DB2® UDB Enterprise Server Edition v8.1
FP5 or FP7

* DB2 UDB Enterprise Server Edition v8.2

* Oracle 8i Standard/Enterprise Release 3
V8.1.7.4

* Oracle 9i Standard /Enterprise Release 2
V9.2.0.5

* Microsoft SQL Server 2000 Enterprise SP3

* Microsoft SQL Server 2000 Standard
Edition

Portal Connector

IBM WebSphere Portal for Multiplatforms
V5.1

Table 3. Development

Windows 2000 development

Requirement

Processor PII processor 500 MHz. PIII 500 MHz or
higher recommended

Memory 1024 MB

Hard drive 2 GB minimum for WebSphere Studio
Application Developer; 4.5 GB minimum for
WebSphere Studio Application Developer
Integration Edition

Display 1024 x 768 minimum at a color setting of

High Color (16 bit)

Operating system

Microsoft Windows 2000 Professional with
Service Pack 4
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Table 3. Development (continued)

Windows 2000 development

Requirement

Integrated development environment

One of the following:

* IBM WebSphere Studio Application
Developer V5.1.1

* IBM WebSphere Studio Application
Developer V5.1.1 Integration Edition

Browser

* Netscape Communicator 7.02 or later with
Java Plug-in 1.3.1 or later

* Internet Explorer 6.0 SP1

Microsoft Windows XP requirements

The following tables list the requirements for Windows XP.

Table 4. Client

Windows XP client

Requirement

Processor PII 266 MHz or higher

Memory 48 MB minimum /64 MB recommended
Hard drive 50 MB

Display 800 x 600 minimum / 1024 x 768

recommended

Intranet test LAN base

16 MB token ring / 100 MB BaseTx Ethernet
recommended

Operating system

Windows XP Professional with SPla

Browser

Any of the following:

* Netscape Communicator 7.02 or later with
Java Plug-in 1.3.1 or later

* Internet Explorer 6.0 SP1

Communication protocol

TCP/IP

JDK

Java 2 SDK supplied by WebSphere
Application Server

Table 5. Development

Windows XP development

Requirement

Processor PII processor. PIII 500 MHz or higher
recommended

Memory 1024 MB recommended

Hard drive 2 GB minimum for WebSphere Studio
Application Developer; 4.5 GB minimum for
WebSphere Studio Application Developer
Integration Edition

Display 1024 x 768 minimum at a color setting of

High Color (16 bit)

Operating system

Windows XP Professional with SP1a
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Table 5. Development (continued)

Windows XP development

Requirement

Integrated development environment

One of the following:
* IBM WebSphere Studio Application
Developer V5.1.1

* IBM WebSphere Studio Application
Developer V5.1.1 Integration Edition

Browser

* Netscape Communicator 7.02 or later with
Java Plug-in 1.3.1 or later

* Internet Explorer 6.0 SP1

Microsoft Windows Server 2003 requirements

The following tables list the requirements for Windows Server 2003.

Table 6. Server

Windows server 2003

Requirement

Processor PII 500 MHz or higher
Hard drive 100 MB minimum
Memory 512 MB minimum / 768 MB recommended

Operating system

On the following;:
* Windows Server 2003 Standard
* Windows Server 2003 Enterprise

Application server

One of the following required:
* IBM WebSphere Application Server V5.1.1

* IBM WebSphere Application Server
Network Deployment V5.1.1

» IBM WebSphere Business Integration
Server Foundation V5.1.1

Communication protocol

TCP/IP

Communication services (LU0, LU6.2)

IBM Communications Server V6.1.2

Database manager

Any of the following:

* DB2 UDB Enterprise Server Edition v8.1
FP5 or FP7

* DB2 UDB Enterprise Server Edition v8.2

* Oracle 8i Standard/Enterprise Release 3
V8.1.7.4

* Oracle 9i Standard /Enterprise Release 2
V9.2.0.5

* Microsoft SQL Server 2000 Enterprise SP3

* Microsoft SQL Server 2000 Standard
Edition

Portal Connector

IBM WebSphere Portal for Multiplatforms
V5.1
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Sun Solaris requirements

The following tables list the requirements for Solaris.

Table 7. Server

Solaris server

Requirement

Processor Sparc workstation at 440 MHz, or faster
Hard drive 100 MB minimum
Memory 768 MB minimum / 1024 MB recommended

Operating system

On the following;:

e Solaris 8 with the Recommended Patch
Cluster of November 2003

e Solaris 9 with the Recommended Patch
Cluster of November 2003

Application server

One of the following required:
* IBM WebSphere Application Server V5.1.1

* IBM WebSphere Application Server
Network Deployment V5.1.1

* IBM WebSphere Business Integration
Server Foundation V5.1.1

Communication protocol

TCP/1P

Database manager

Any of the following:

* DB2 UDB Enterprise Server Edition v8.1
FP5 or FP7

* DB2 UDB Enterprise Server Edition v8.2

* Oracle 8i Standard/Enterprise Release 3
V8.1.7.4

* Oracle 9i Standard/Enterprise Release 2
V9.2.0.5

Portal Connector

IBM WebSphere Portal for Multiplatforms
V5.1

Linux on Intel requirements

The following tables list the requirements for Linux on Intel platforms.

Table 8. Client

Linux client

Requirement

Processor PII 233 MHz or higher

Memory 48 MB minimum / 64 MB recommended
Hard drive 50 MB

Display 800 x 600 minimum / 1024 x 768

recommended

Intranet test LAN base

16 MB token ring / 100 MB BaseTx Ethernet
recommended
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Table 8. Client (continued)

Linux client

Requirement

Operating system

On the following;:
* Red Hat 8.0
* Red Hat 9.0

* Red Hat Enterprise Linux WS 3.0 Update
lor3

Browser

Netscape Communicator 7.02 or later with
Java Plug-in 1.3.1 or later

Communication protocol

TCP/1P

JDK

Java 2 SDK supplied by WebSphere
Application Server

Table 9. Server

Linux server

Requirement

Processor PII 500 MHz or higher
Hard drive 100 MB minimum
Memory 512 MB minimum / 768 MB recommended

Operating system

On the following;:
* Red Hat Enterprise Linux AS 3.0 Update 1
or 3

* Red Hat Enterprise Linux ES 3.0 Update 1
or 3

Application server

One of the following required:

+ IBM WebSphere Application Server V5.1.1

* IBM WebSphere Application Server
Network Deployment V5.1.1

* IBM WebSphere Business Integration
Server Foundation V5.1.1

Communication protocol

TCP/IP

Communication services (LU0, LU6.2)

Communications Server for Linux V6.1.2

Database manager

Any of the following:

* DB2 UDB Enterprise Server Edition v8.1
FP5 or FP7

* DB2 UDB Enterprise Server Edition v8.2

* Oracle 8i Standard/Enterprise Release 3
V8.1.7.4

* Oracle 9i Standard /Enterprise Release 2
V9.2.0.5

Portal Connector

IBM WebSphere Portal for Multiplatforms
V5.1

Table 10. Development

Linux development

Requirement

Processor PII processor 500 MHz. PIII 500 MHz or
higher recommended
Memory 1024 MB
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Table 10. Development (continued)

Linux development

Requirement

Hard drive 2 GB minimum for WebSphere Studio
Application Developer; 4.5 GB minimum for
WebSphere Studio Application Developer
Integration Edition

Display 1024 x 768 minimum at a color setting of 16

bit for workstation

Operating system

Red Hat Linux v7.2 or later

Integrated development environment

Required for development workstations:

One of the following:

* IBM WebSphere Studio Application
Developer V5.1.1

* IBM WebSphere Studio Application
Developer V5.1.1 Integration Edition

Browser

Netscape Communicator 7.02 or later with
Java Plug-in 1.3.1 or later

IBM AIX requirements

The following tables list the requirements for AIX.

Table 11. Server

AIX server Requirement

Processor IBM eServer" pSeries® at 375 MHz or
higher frequency

Hard drive 100 MB minimum

Memory 512 MB minimum / 768 MB recommended

Operating system

One of the following:

e AIX Version 5.1 with the 5100-05
recommended maintenance package

* AIX Version 5.2 with the 5200-01
recommended maintenance package,
APAR iY44183, and PTF U484272

* AIX Version 5.2 with the 5200-03
recommended maintenance package

* AIX 5L version 5.3 with WebSphere
Application Server APAR PK01428

Application server

One of the following required:
* IBM WebSphere Application Server V5.1.1

* IBM WebSphere Application Server
Network Deployment V5.1.1

* IBM WebSphere Business Integration
Server Foundation V5.1.1

Communication protocol

TCP/IP

Communication services (LUO, LU6.2)

IBM Communications Server V6.1.2
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Table 11. Server (continued)

AIX server

Requirement

Database manager

One of the following:

* DB2 UDB Enterprise Server Edition v8.1
FP5 or FP7

* DB2 UDB Enterprise Server Edition v8.2

* Oracle 8i Standard/Enterprise Release 3
V8.1.7.4

* Oracle 9i Standard/Enterprise Release 2
V9.2.0.5

Portal Connector

IBM WebSphere Portal for Multiplatforms
V5.1

IBM z/OS requirements

The following tables list the requirements for z/OS.

Table 12. Server

zSeries® server

Requirement

Processor Any hardware that supports z/OS 1.2 or
z/0OSe 1.3, or even later versions. S/390
Parallel Enterprise Server’ " Generation 5 or
6, or ever later systems is recommended

Hard drive 100 MB minimum

Memory 512 MB minimum /768 MB recommended

Operating system

z/0S (5694-A01) 1.2 or later

Application server

One of the following required:

* IBM WebSphere Application Server for
z/OS V5.1

» IBM WebSphere Business Integration
Server Foundation for z/OS V5.1

Communication protocol

TCP/IP

Communication services (LUO, LU6.2)

IBM Communications Server V6.1.2

Database manager

One of the following:
» IBM DB2 Universal Database™ V7.0 for
z/0S

e IBM DB2 Universal Database V8.0 for
z/0S

Portal Connector

IBM WebSphere Portal for Multiplatforms
V5.1

Additional requirements

Depending on the framework services you use, you may require other hardware
and software to support financial devices. The following additional requirements
apply to the type of workstation (client, server, or development) that accesses the

financial device.
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Table 13. Additional financial devices requirements

Framework component Additional requirements

J/eXtensions for Financial Services Any financial printer, magnetic stripe
reader/encoder, or check reader with a
device service that is compliant with the
J/XFS specification

eXtensions for Financial Services Any financial printer, magnetic stripe
reader/encoder, or check reader with a
device service that is compliant with the
J/XFS specification

LANDP® MSR/E Device Service Any magnetic stripe reader/encoder
supported by the LANDP MSRE47## server

Setting up a Branch Transformation Toolkit development environment

In this procedure, you set up a development workstation so that you can develop
applications based on IBM Branch Transformation Toolkit for WebSphere Studio
5.1. Note that the physical machine must comply to the requirements listed in the
Hardware and software requirements section, including having WebSphere Studio
Application Developer Integration Edition.

Note: The following procedure describes how to install the Branch Transformation
Toolkit on top of WebSphere Studio Application Developer or WebSphere
Studio Application Developer Integration Edition. Each functional unit is
contained in its own JAR file to provide greater flexibility both in the
development environment and in runtime. Consider reviewing Functional
units, packages, and dependencies to decide which functional units you
need to develop your application. Note, however, that you can add or
remove functional units at any time provided you account for their
corequisite functional units (functional units that must also exist on the
system at the same time).

Installation package structure

The Branch Transformation Toolkit installation package mainly contains two
groups of components - components for the development environment and
components for the runtime environment.

Development environment

For the development environment, Branch Transformation Toolkit 5.1 supports
WebSphere Studio Application Developer 5.1.1 and WebSphere Studio Application
Developer Integration Edition 5.1.1.

For the development environment, there are two sets of plug-ins including
different files:

* Plug-ins for WebSphere Studio Application Developer 5.1.1

These plug-ins do not include any component that do not have dependencies on
features provided by WebSphere Studio Application Developer Integration
Edition 5.1.1.

* Plug-ins for WebSphere Studio Application Developer Integration Edition
5.1.1

10 IBM Branch Transformation Toolkit for WebSphere Studio: Installation guide



These plug-ins include components that have dependencies on features provided
by WebSphere Studio Application Developer Integration Edition 5.1.1, such as
plug-ins for the Business Process BTT Wizard.

If you have WebSphere Studio Application Developer Integration Edition 5.1.1
installed on your system, the toolkit installation wizard will take WebSphere
Studio Application Developer Integration Edition as your development
environment, regardless if you have WebSphere Studio Application Developer
installed as well. After the installation wizard decides that WebSphere Studio
Application Developer Integration Edition is your development environment, it
copies the plug-ins for WebSphere Studio Application Developer Integration
Edition 5.1.1 to the wstools/eclipse/plugins directory of your WebSphere Studio
Application Developer Integration Edition 5.1.1 automatically during the
installation.

If you have WebSphere Studio Application Developer 5.1.1 installed on your
system, the toolkit installation wizard will take WebSphere Studio Application
Developer as your development environment. After the installation wizard decides
that WebSphere Studio Application Developer is your development environment, it
copies the plug-ins for WebSphere Studio Application Developer 5.1.1 to the
wstools/eclipse/plugins directory of your WebSphere Studio Application
Developer 5.1.1 automatically during the installation.

If neither WebSphere Studio Application Developer 5.1.1 nor WebSphere Studio
Application Developer Integration Edition 5.1.1 is installed on your system, you
will need to copy the plug-ins to the wstools/eclipse/plugins directory by yourself
after you have WebSphere Studio Application Developer or WebSphere Studio
Application Developer Integration Edition installed later. Plug-ins for WebSphere
Studio Application Developer can be found in the <tookit_root>/plugins/wsad51
dirctory, and plug-ins for the WebSphere Studio Application Developer Integration
Edition can be found in the <tookit_root>/plugins/wsadie51 directory.

Runtime environment

For the runtime environment, Branch Transformation Toolkit 5.1 supports
WebSphere Application Server 5.1.1 and WebSphere Business Integration Server
Foundation 5.1.1.

For the runtime environment, there are two sets of runtime data including different
files:

* Runtime data for WebSphere Application Server 5.1.1

These runtime data do not include components that have dependencies on
features provided by WebSphere Business Integration Server Foundation.

* Runtime data for WebSphere Business Integration Server Foundation 5.1.1

These runtime include components that have dependencies on features provided
by WebSphere Business Integration Server Foundation, such as the Business
Process Component, startup beans, work area, and components using activity
sessions.

Depending on the development environment you have on your workstation, the
Branch Transformation toolkit installation wizard decides the runtime environment

to install for you.

If you have WebSphere Studio Application Developer Integration Edition installed
on your workstation, or you have neither edition of the application developer
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installed, the installation wizard will prompt if you want to install the runtime
environment for WebSphere Business Integration Foundation, or the runtime
environment for WebSphere Application Server.

If you have WebSphere Studio Application Developer installed on your
workstation, the installation wizard will automatically take WebSphere Application
Server as your runtime environment, and install the runtime data accordingly for
you.

Installing the Branch Transformation Toolkit on a development
workstation

To set up the development workstation, do the following:

1. According to your business need, install WebSphere Studio Application
Developer or WebSphere Studio Application Developer Integration Edition.

2. Insert the Branch Transformation Toolkit CD into the workstation and browse
the CD. If you want to install Branch Transformation Toolkit 5.1 for windows,
run C55HDML.exe in the Windows platform. If you want to install Branch
Transformation Toolkit 5.1 for Linux, run C55HEML.bin in the Linux platform.
This starts the Installation Wizard for Branch Transformation Toolkit.

3. During the installation, the Installation Wizard detects if any version of Branch
Transformation Toolkit is installed on your system. Branch Transformation
Toolkit version 5.1 can coexist with that of version 4.3. If you already have
version 5.1 installed, the Installation Wizard will display a warning that you
already have version 5.1 installed. If you continue with the installation, your
previous installation of version 5.1 will be overridden.

4. The Installation Wizard also checks the WebSphere Studio Application
Developer you installed. If you installed WebSphere Studio Application
Developer, the Install Wizard will install toolkit components designed for
WebSphere Studio Application Developer and those for WebSphere Application
Server. If you have WebSphere Studio Application Developer Integration
Edition installed, the Install Wizard will install toolkit components designed for
WebSphere Studio Application Developer Integration Edition, and it will
prompt you which set of runtime components you want to install - components
designed for the WebSphere Application Server, or components designed for
WebSphere Business Integration Server Foundation.

The Branch Transformation Toolkit installation program creates the following
set of directories on the target machine.

Table 14. Directories created by installation

Directory name Description of contents

dbtools Scripts to manage database tables for the
CHA component

desktop Desktop DTD file

doc The Branch Transformation Toolkit
documentation plug-ins to WebSphere
Studio Application Developer Integration
Edition
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Table 14. Directories created by installation (continued)

Directory name

Description of contents

plugins

* Visual beans plug-in to WebSphere Studio
Application Developer Integration Edition

* Eclipse Modeling Framework (EMF)
plug-in

* Graphical Builder plug-in

* Struts Tools BTT Extensions plug-in

* CHA Editor plug-in

* Format Editor plug-in

* Business Process BTT Wizard plug-in

* Migration Tool plug-in

ear

EAR files to provide the infrastructure for
the CHA, CHA formatter service, and
Service Infrastructure components of the
toolkit. You can use the EARs to build
applications on the Branch Transformation
Toolkit

jars

The Branch Transformation Toolkit code
separated into various JARs according to the
functional unit to which the code belongs.

A solution built on the Branch
Transformation Toolkit can use the JARs for
the functional units that it is using. See
Functional units, packages, and
dependencies for a listing of the JARs and
their contents and corequisites

samples

EAR files to run the sample applications
provided by the Branch Transformation
Toolkit in the WebSphere Studio Application
Developer workbench. This directory also
contains the source code of the samples.

services

Runtime files that are needed by some of the
services of the framework

source

Source code of selected Branch
Transformation Toolkit components to
provide a better understanding of the
functional units. This helps in tasks such as
extending the framework and reduces the
development cycle. The source code must
not be modified

javadoc

source:

Start WebSphere Studio Application Developer.
Set some preferences before you import Branch Transformation Toolkit Java

* To work with complex projects, you should use the source folders as source
containers instead of creating packages directly inside the project. To do this,
you create source folders as children of the project and create your packages
inside these source folders. To automate this, go to Window > Preferences.
Expand the Java node and select the New Project node. Enable the Folders

check box.
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* To develop with the Branch Transformation Toolkit, add the framework
functional units (the JAR files containing the classes) to the application
classpath. You can use any approach to do this but you must account for the
class loader policies.

A recommended approach is to add an overall classpath variable named BTT
to point to the root directory of the Branch Transformation Toolkit
installation. To do this:

a. Go to Window - Preferences.

b. Expand the Java node and select Classpath Variables.

c. Click New and in the Name entry field, type the following;:
BTT

d. In the Path entry field, type the path to where the Branch Transformation
Toolkit was installed.

e. Click OK.

In the same way, add another classpath variable named, for example,
BTT_EXTERNAL to point to the external dependencies. To make the external
classpath variable work, all the required external JARs must be in the
directory to which this variable points. The overall classpath variables make
it easier for you to select the Branch Transformation Toolkit JAR files for
your Java project.

Another approach is to define a classpath variable for each functional unit
available in the product. Each classpath variable points to the concrete JAR
associated with the functional unit (see the tables in Functional units,
packages, and dependencies).

The remainder of this procedure and all the other procedures assume that
you are using the recommended approach.

7. Create a Java project for application. To create the project:
a. Select File > New - Project.

b. Select Java in the left panel and then select Java Project in the right panel.
Click Next.

c. Type the name of the project, such as HomeBanking, and click Finish.

8. When deploying an application, you must embed Branch Transformation
Toolkit functional units, along with the required application resources, inside
the J2EE EAR file. The Branch Transformation Toolkit uses functional units to
provide a coherent structure of JAR files that you use to build an application.
The JARs in the functional units contain the required set of classes for a given
execution environment.

To make the functional units available to your project, you can either add the
compiled JARs to the project’s classpath or you can import the JARs into the
workspace. You can choose the second option if you want to embed the JARs
and resources into your application when, for example, it is self-contained and
independently deployed.

For either option, you only add or import the JARs and their corequisites
needed for the application to optimize the deployment and distribution of the
application. Consult Functional units, packages, and dependencies to obtain
these corequisites.

If you are unsure of the actual dependencies among the JARs, add the ones
that you are not sure about. You can always remove unneeded jars later. For
examples of the JARs that you should select, browse the list of jars used by the
sample applications shipped in the <Toolkit root>/samples folder. If you open,
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for example, the BITHtmISampleWeb.war file that is inside the
BBTTHtmlSample.ear file, you can see that the following functional units have
been used to build the application:

* BTTBase(bttbase.jar)

* BTTInvoker(bttinvoker.jar)

¢ BTTJavaClient(bttjavaclient.jar)

* BTTServerBean(bttsvrbeanjar)

* BTTSessionManagement(bttsm.jar)

¢ BTTStrutsExtension(bttstruts.jar)

e BITHTMLSampleE]B(BTTHTMLSampleE]B.jar)

To add the required JARs to the project’s classpath:

a. Right-click the project and select Properties.

b. Select JavaBuildPath and then select the Libraries tab.

C. Select Add Variable and, in the New Variable Classpath Entry window,
select the classpath variable ( BTT) and click Extend.

d. In the Variable Extension window, expand the jars directory and select the
BTT JAR that you want to add to your project. Click OK.

e. If the JAR you have just added to your project has source code shipped
with the Branch Transformation Toolkit (see Functional units, packages, and
dependencies), you may want to attach the source code to the JAR to enable
source-level stepping and browsing of classes contained in the binary JAR

file. To do this:
1) Click Attach Source.

2) In the Attachments For BTT /jars/<JAR name>.jar window, click the
Variable button next to the Archive variable path text field.

3) Select the classpath variable (BTT) and click OK.
4) Click Extension.

5) In the JAR/ZIP File Selection window, open the source directory and
double click the ZIP file containing the source code corresponding to the
JAR file you added to your project. Click OK.

f. Repeat this procedure for each JAR file that you want to add. Keep in mind
the dependencies that a JAR or functional unit may have. Consult Appendix
A to obtain these dependencies.

Once you have installed the Branch Transformation Toolkit in WebSphere Studio
Application Developer Integration Edition, you can start developing Branch
Transformation Toolkit-based solutions. For a high level overview of the
development process and where to get information, see the Creating an application
documentation. For examples of Branch Transformation Toolkit-based applications,
including how to install and run them on the various supported platforms, see the
Java Sample Application and HTML Sample Application documentation.

Setting up the CHA Editor
The CHA Editor for the Branch Transformation Toolkit is a WebSphere Studio
plug-in. CHA Editor configuration files (or CHA Editor files) help you create CHA

elements with a graphical user interface.

Prerequisites to use the CHA Editor:
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 If you had installed the toolkit before you installed the WebSphere Studio
Application Developer Integration Edition, you need to copy the following
plug-in files to the wstools\eclipse\plugins\ folder of your WebSphere Studio
installation folder:

— com.ibm.btt.tools.common_5.1.0
— com.ibm.btt.tools.chaeditormodel.emf 5.1.0
— com.ibm.btt.tools.chaeditor_5.1.0

To create a CHA Editor file, follow these steps:
1. Start Application Developer Integration Edition.

2. Create a simple project to contain the CHA Editor files.

3. From the File menu, select File » New » Other.

4. In the dialog, select IBM Branch Transformation Toolkit in the left panel.
5. In the right panel, select CHA Editor file. This starts the CHA Editor

Configuration Wizard.

6. Select the project to contain the CHA Editor’s files. Usually this is the project
file for the application you are creating.

7. In the file name field, type the name of the editor’s configuration file. The file
must have the .chae extension.

8. Click Finish.
9. From the menu bar, select Window » Show view > Other.

10. In the window that pops up, expend IBM Branch Transformation Toolkit,
and select the CHA Editor views that you want to show.

The wizard then creates the configuration file and the dsedata.xml, dsetype.xml,
and dsectxt.xml files in the project folder. It then launches the CHA Editor.

Setting up the Format Editor

The Format Editor for the Branch Transformation Toolkit is a WebSphere Studio
plug-in. Format Editor configuration files (or Format Editor files) help you create
formatters with a graphical user interface.

Prerequisites to use the Format Editor:

* If you had installed the toolkit before you installed the WebSphere Studio
Application Developer Integration Edition, you need to copy the following
plug-in files to the wstools\eclipse\plugins\ folder of your WebSphere Studio
installation folder:

— com.ibm.btt.tools.common_5.1.0
— com.ibm.btt.tools.fmteditor_5.1.0
— com.ibm.btt.tools.chaeditor_5.1.0

To create a Format Editor file, follow these steps:
1. Start Application Developer Integration Edition.

2. Create a simple project to contain the Format Editor files.

3. From the File menu, select File » New » Other.

4. In the dialog, select IBM Branch Transformation Toolkit in the left panel.
5. In the right panel, select Format Editor file. This starts the Format Editor

Configuration Wizard.
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6. Select the project to contain the Format Editor’s files. Usually this is the
project file for the application you are creating.

7. In the file name field, type the name of the editor’s configuration file. The file
must have the .fmte extension.

Note: Each Format Editor file works with a CHA Editor file to provide the
formatters for the CHA elements described in the CHA Editor file. You
should define the CHA Editor file name in the configuration of the
Format Editor file to ensure they can work together.

8. Click Finish.
9. From the menu bar, select Window » Show view > Other.

10. In the window that pops up, expend IBM Branch Transformation Toolkit,
and select the Format Editor views that you want to show.

The wizard then creates the configuration file and the dsefmt.xml file in the project
folder. It then launches the Format Editor.

Setting up the Business Process BTT Wizard

The Business Process BTT Wizard for the Branch Transformation Toolkit is a
WebSphere Studio plug-in. Business Process configuration files (or Business Process
files). The Business Process BTT Wizard provides a graphical user interface (GUI)
to help you extend your business processes for taking advantage of the BTT
Abstract Layer.

Prerequisites to use the Business Process BTT Wizard:

 If you had installed the toolkit before you installed the WebSphere Studio
Application Developer Integration Edition, you need to copy the following
plug-in files to the eclipse\wstools\plugins\ folder of your WebSphere Studio
installation folder:

— com.ibm.btt.tools.common_5.1.0
— com.ibm.btt.tools.bp_5.1.0

Setting up the Struts Tools BTT Extensions

The Struts Tools BTT Extensions for the Branch Transformation Toolkit is a
WebSphere Studio plug-in. Struts Tools BTT Extensions configuration files (or
Struts Tools BTT Extensions files). The Struts Tools BTT Extensions provides a
graphical and easier way to work with toolkit extended Struts configuration files.

Prerequisites to use the Struts Tools BTT Extensions:

* If you had installed the toolkit before you installed the WebSphere Studio
Application Developer Integration Edition, you need to copy the following
plug-in files to the wstools\eclipse\plugins\ folder of your WebSphere Studio
installation folder:

— com.ibm.btt.tools.common_5.1.0
— com.ibm.btt.tools.struts_5.1.0
— com.ibm.btt.tools.webdiagrameditor_5.1.0
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Setting up the Graphical Builder

The Graphical Builder for the Branch Transformation Toolkit is a WebSphere Studio
plug-in. the Graphical Builder configuration files (or the Graphical Builder files).
The Graphical Builder integrates all developing tools and provides a new way of
visualization, integrated development, and seamless deployment technique that
applies to the full lifecycle of your application development.

Prerequisites to use the Graphical Builder:

 If you had installed the toolkit before you installed the WebSphere Studio
Application Developer Integration Edition, you need to copy the following
plug-in files to the wstools\eclipse\plugins\ folder of your WebSphere Studio
installation folder:

— com.ibm.btt.tools.common_5.1.0

— com.ibm.btt.tools.chaeditormodel.emf 5.1.0
— com.ibm.btt.tools.chaeditor_5.1.0

— com.ibm.btt.tools.fmteditor_5.1.0

— com.ibm.btt.tools.fmteditormodel.emf_5.1.0
— com.ibm.btt.tools.struts_5.1.0

— com.ibm.btt.tools.webdiagrameditor_5.1.0
— com.ibm.btt.tools.bp_5.1.0

— com.ibm.btt.tools.gw_5.1.0

— com.ibm.btt.tools.gw.model.emf_5.1.0

— com.ibm.btt.tools.migration_5.1.0

Setting up the migration tool

The migration tool is a WebSphere Studio Application Developer plug-in that helps
you migrate your version 4.3 toolkit applications to version 5.1 applications.

Prerequisites to use the migration tool:

 If you had installed the toolkit before you installed the WebSphere Studio
Application Developer Integration Edition, you need to copy the following
plug-in files to the wstools\eclipse\plugins\ folder of your WebSphere Studio
installation folder:

— com.ibm.btt.tools.common_5.1.0

— com.ibm.btt.tools.chaeditormodel.emf 5.1.0
— com.ibm.btt.tools.chaeditor_5.1.0

— com.ibm.btt.tools.fmteditor_5.1.0

— com.ibm.btt.tools.fmteditor.model.emf 5.1.0
— com.ibm.btt.tools.struts_5.1.0

— com.ibm.btt.tools.webdiagrameditor_5.1.0
— com.ibm.btt.tools.bp_5.1.0

— com.ibm.btt.tools.gw_5.1.0

- com.ibm.btt.tools.gw.model.emf 5.1.0

— com.ibm.btt.tools.migration_5.1.0

18 IBM Branch Transformation Toolkit for WebSphere Studio: Installation guide



Installing toolkit applications on a runtime platform

Installing Branch Transformation Toolkit applications on a runtime platform
consists of deploying EAR files onto WebSphere Application Server. You develop a
solution in WebSphere Studio Application Developer Integration Edition and
package the code and resources for the solution in EAR files. You can do the
packaging using WebSphere Studio Application Developer Integration Edition or
using the Application Assembly Tool in WebSphere Application Server.

The Branch Transformation Toolkit provides four sample applications that you can
immediately deploy on WebSphere Application Server after you make a few
customizations to adapt the sample applications to your particular requirements.
See the deployment section of Java Sample Application and HTML Sample
Application documentation for this information. The sample application
documentation will also provide you with guidance on deploying your own

applications.

Functional units, packages, and dependencies

This section identifies the external dependencies and framework corequisites for
each functional unit. You must load these dependencies and corequisites to have a
clean development environment. In addition to the components provided by the
required features for the Branch Transformation Toolkit, you may need other
external packages. See Obtaining missing prerequisites for a list of these packages.

The tables below include a brief description of the functional unit, whether it also
has source code, and the functional unit’s ZIP file. Each row shows the direct

framework corequisites and the corequisites of these corequisites.

Table 15. External dependencies and corequisites for functional units-JAR files

Functional unit or

JAR Name component Source ZIP name External dependency Corequisite JAR
bttbase Basic framework component | BTTBase J2EE, Activity Session , ras.jar dseb
BTTCHAE]B CHA BTTCHA J2EE bttbase
bttevent BTT Event BTTEvent J2EE dseb, bttbase,
bttjavaclient, bttsm,
bttinvoker, dsesym
bttfmt BTTFormatterEJB Formatter BTTFormatter J2EE, gqname.jar, WSDL, Web bttbase, BTTCHAE]B
Services Invocation Framework,
SOAP, Java Mail, activation jar,
xerces.jar, xalan.jar, wsatlib jar,
commons-logging-api.jar
bttinvoker EJB invocation framework BTTInvoker J2EE, webcontainerjar, bttbase, bttevent,
ivjejb35.jar, websphere jar, Work | bttjavaclient, bttsm, dseb,
Area, wsif jar, wsdl4jjar, dsesym
wsatlib jar
bttjavaclient Java client support BTTJavaClient J2EE bttbase, bttinvoker,
bttsm, dseb
bttjdbjsvc Jdbc Table Service BTTJdbcJournalService J2EE, servleteventjar, ivjejb35.jar, | bttbase, bttfmt,
runtime.jar bttjdbtsvc, bttsvcinfra
bttjdbtsvc Jdbc Journal Service BTTJ]dbcTableService utils jar bttbase, bttfmt,
bttsvcinfra
bttsm session management BTTSessionManagement | J2EE, activitySession.jar bttbase
bttstruts HTML client in BTT5.1 BTTStrutsExtension Apache Struts 1.1, J2EE, wsifjar, | bttbase, bttinvoker,
WSDL bttsm, dseb
bttstrutsportal Fully Portal support BTTStrutsPortal Apache Struts 1.1, Portal Server | bttbase, bttevent,

5.1, J2EE, wsif jar, WSDL,
dynacache jar

bttinvoker, bttsm,
bttstruts
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Table 15. External dependencies and corequisites for functional units-JAR files (continued)

Functional unit or

JAR Name component Source ZIP name External dependency Corequisite JAR
bttsvcinfra Services Infra BTTServicesInfra J2EE Web Services Invocation bttbase
Framework, WSDL, QName,
Xerces Java Parser,
commons-logging-api.jar, Xalan,
SOAP, Java Mail, activation.jar
bttsvrbean Single Action EJB BTTServerBean Work Area bttbase, bttfmt,
bttsvcinfra
bttsvrflow BTT Business Process BTTServerFlow Work Area, QName, ras.jar, Web | bttbase, bttfmt,
Services Invocation Framework, | bttsvcinfra
WSDL, bpe jar
BTTStartupEJB BTT Startup BTTStartup J2EE bttbase
dseb Basic framework component | DSEBase J2EE Java Servlet API (server
only)
dsecsm Client/Server mechanism DSEClientServer SSLight.jar dsecss, dsesym, dseb
Mechanism
dsecss Client/Server support DSEClientServer Support |J/XFS dseb
dsed Desktop DSEDesktop Java Help, J2EE dseflp, dsegb, dseb
dseflp Flow processor DSEFlowProcessor dseb
dseflpeclt Flow Processor extensions DSEFlowProcessor dseb, dsed, dsegb, dseflp
(client) ExtClient
dsegb GUI Beans DSEGuiBeans SWT dseb
dsejxbsvc JXFS service base N/A J/XES dseb
dsejxcsve JXFS Check Reader N/A J/XFS dsejxbsvc, dseb
dsejxpsve JXFS Print service N/A J/XFS dsejxbsvce, dseb
dselansvc Access to LANDP MSR/E N/A LANDP dseb
server
dsesci Common infrastructure for N/A dseb
services
dsesym System Management N/A
dsetde Typed data extensions DSETypedData dseb
Extensions
dsewojxdsi J/XFS device service N/A J/XFS dsewossvce, dseb
infrastructure (WOSA based)
dsewomijxds J/XFS MSR/E device service |N/A J/XFS dsewojxdsi, dseb
(WOSA based)
dsewopjxds J/XFS printer device service | N/A J/XFS dsewojxdsi, dsewossvc,
(WOSA based) dseb
dsewossvc WOSA support N/A dseb

Table 16. External dependencies and corequisites for functional units-WAR files

Functional unit or
WAR name component Source ZIP name External dependency |Corequisite JAR
BTTCHAWeb(for BTTCHAWeb N/A bttbase
WebSphere
Application Server
only)
BTTServicesInfraWeb | BTTServicesInfra N/A bttbase
BTTStartupWeb(for BTTStartup N/A bttbase
WebSphere
Application Server
only)
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Table 17. External dependencies and corequisites for functional units-RAR files

RAR name Functional unit or component Source ZIP name | External dependency Corequisite JAR

dummysnalu0 | BTTDummySnaLuOConnector N/A J2EE JCA

snalu0 DSELuOConnector N/A Communication Server J2EE JCA
DSELu0OConnector]caPlugin WSIF

snalu62 BTTLu62Connector N/A Communication Server J2EE JCA
BTTLu62Connector]caPlugin WSIF

The following samples are only provided in source code contained in ZIP files:

Table 18. Source ZIP files and dependencies for samples

Sample Source ZIP name Dependency

Sample of how to use the LANDP DSELandpSample dseb, dselansvc, dsencsi
MSR/E access service

Sample of how to use the WOSA DSEWosaSample dseb, dsewossvc
service

Sample of how to use the BTTServicesSample bttbase, bttsvcinfra
BTTServices

The following table lists the sample EAR files, their source or compiled code file,
and any corequisites.

Table 19. Source ZIP and EAR files and external and corequisites for the Samples

Sample

Source ZIP and EAR files

External Corequisite

Corequisite JAR

HTML Sample Application

BTTHTMLSample.ear

bttbase, bttinvoker, bttfmt,
bttjavaclient, bttjdbjsvc,
bttjdbtsvc, bttsm, bttstruts,
bttsvrbean, bttsvcinfra

HTML Sample BP
Application

BTTHTMLSampleBPEAR.ear

bttbase, BITTCHAE]B, bttfmt,
BTTFormatterEJB, bttjdbjsvc,
bttjdbtsvc, bttsvrbean,
bttsvrflow, bttsvcinfra,

sn0dummy

Java Sample BTTCHAFMTServer.ear, bttbase, bttfmt, bttjdbjsvc,

Application- BTTJavaSample.ear bttjdbtsvc, bttsvcinfra,

CHAFMTSeperated bttsvrbean, dsecsm, dsecss,
dsed, dseflp, dseflpeclt, dsegb,
dsejxpsvc, dsesci, dsesym,
dsetde, sn0dummy

Java Sample BTTCHAEAR .ear,

Application-MultiCHA BTTJavaSample.ear

Java Sample BTTJavaSample.ear

Application-Stand Alone

Portal HTML Sample

BTTPortalHTMLSample.ear

bttbase, bttfmt, bttjdbjsvc,

Application bttjdbtsvc, bttinvoker,
bttjavaclient, bttsvrbean, bttsm,
bttstruts, bttsvcinfra

WCA Sample Application com.ibm.btt.wci.sample Eclipse v3.0.0 dseb, dsed, dseflp, dsegb
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The following table lists the packages included in the product and the JAR, RAR or
ZIP files that contain them. Note that some Java packages are in more than one
JAR to optimize the contents of the JAR files.

Table 20. JAR, RAR or ZIP files for packages

Package name JAR/RAR/ZIP name
com.ibm.btt.base bttbase.jar, BTTBase.zip
com.ibm.btt.base.types bttbase.jar, BTTBase.zip
com.ibm.btt.base.types.ext bttbase jar, BTTBase.zip
com.ibm.btt.cha.ejb bttbase.jar, BTTBase.zip, BITCHAE]B.jar, BITCHA.zip
com.ibm.btt.clientserver bttjavaclient.jar, BTTJavaClient.zip
com.ibm.btt.cs.invoker.base bttinvoker.jar, BTTInvoker.zip
com.ibm.btt.cs.invoker.base.xml bttinvokerjar, BTTInvoker.zip
com.ibm.btt.cs.invoker.cache bttinvoker.jar, BTTInvoker.zip
com.ibm.btt.cs java bttjavaclient.jar, BTTJavaClient.zip
com.ibm.btt.cs.servlet bttjavaclient.jar, BTTJavaClient.zip
com.ibm.btt.cs.sessionpropagation bttinvokerjar, BTTInvoker.zip
com.ibm.btt.event bttevent.jar, BTTEvent.zip
com.ibm.btt.formatter.client bttfmt.jar, BTTFormatter.zip, BTTFormatterE]B.jar
com.ibm.btt.formatter.server bttfmt.jar, BTTFormatter.zip, BTTFormatterE]B.jar
com.ibm.btt.misc bttbase jar, BTTBase.zip, BITCHAE]B jar, BITCHA.zip,
BTTStartupE]B.jar BTTStartup.zip
com.ibm.btt.samples.business.sna.lu0 dummysnalu0.rar
com.ibm.btt.samples.business.sna.lu0.exception dummysnalu0.rar
com.ibm.btt.samples.business.sna.lu0.host dummysnalu0.rar
com.ibm.btt.samples.business.sna.lu0.host.event dummysnalu0.rar
com.ibm.btt.samples.business.sna.lu0.resource dummysnalu0.rar
com.ibm.btt.samples.business.sna.lu0.services dummysnalu0.rar
com.ibm.btt.samples.business.sna.util dummysnalu0.rar
com.ibm.btt.server.bean bttsvrbean.jar, BTTServerBean.zip
com.ibm.btt.server.flow bttsvrflow.jar, BTTServerFlow.zip
com.ibm.btt.server.flow.al.base bttsvrflow.jar, BTTServerFlow.zip
com.ibm.btt.server.flow.al.mapping bttsvrflow.jar, BTTServerFlow.zip
com.ibm.btt.server.flow.al. workarea bttsvrflow.jar, BTTServerFlow.zip
com.ibm.btt.server.flow.mapper bttsvrflow.jar, BTTServerFlow.zip
com.ibm.btt.server.flow.message bttsvrflow.jar, BTTServerFlow.zip
com.ibm.btt.services bttsvcinfra.jar, BTTServicesInfra.zip
com.ibm.btt.services.jdbcjournalservice bttjdbjsvc.jar
com.ibm.btt.services.jdbcservicesinfra bttjdbtsvc.jar
com.ibm.btt.services.jdbctableservice bttjdbtsvc.jar
com.ibm.btt.sample.appl BTTJavaSample.ear, bttwcisample.jar
com.ibm.btt.sample.html BTTHTMLSample.ear
com.ibm.btt.services.sample BTTServicesSample.zip
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Table 20. JAR, RAR or ZIP files for packages (continued)

Package name

JAR/RAR/ZIP name

com.ibm.btt.sm

bttsm.jar, BTTSessionManagement.zip

com.ibm.btt.sm.as

bttsm.jar, BTTSessionManagement.zip

com.ibm.btt.struts

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.actions

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.base

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.config

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.exception

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.plugins

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.session

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.taglib.html

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.utils

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.wsif

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.strutsportal.actions

bttstrutsportal jar, BTTStrutsPortal.zip

com.ibm.btt.strutsportal.base

bttstrutsportal.jar, BTTStrutsPortal.zip

com.ibm.btt.strutsportal.taglib.html

bttstrutsportal jar, BTTStrutsPortal.zip

com.ibm.btt.wci.sample bttwcisample jar
com.ibm.connector2.sna.lu0 snalu0.rar
com.ibm.connector2.sna.lu0.exception snalu0.rar
com.ibm.connector2.sna.lu0.host snaluQ.rar
com.ibm.connector2.sna.lu0.host. event snalu0.rar
com.ibm.connector2.sna.lu0.resource snalu0.rar
com.ibm.connector2.sna.lu0.tools snalu0.rar
com.ibm.connector2.sna.lu0.tools.resources snalu0.rar
com.ibm.connector2.sna.lu0.util snalu0.rar

com.ibm.connector2.sna.lu62

snalu62.rar

com.ibm.connector2.sna.lu62.exception

snalu62.rar

com.ibm.connector2.sna.lu62.host

snalu62.rar

com.ibm.connector2.sna.lu62.host. event

snalu62.rar

com.ibm.connector2.sna.lu62.resource

snalu62.rar

com.ibm.connector2.sna.lu62.tools

snalu62.rar

com.ibm.connector2.sna.lu62.tools.resources

snalu62.rar

com.ibm.connector2.sna.lu62.util

snalu62.rar

com.ibm.connector2.sna.services

snalu62.rar

com.ibm.connector2.sna.util

snalu62.rar snalu0.rar

com.ibm.dse.automaton

dseflp.jar, DSEFlowprocessor.zip

com.ibm.dse.automaton.ext.client

dseflpeclt.jar, DSEFlowProcessorExtClient.zip

com.ibm.dse.base

dseb.jar, DSEBase.zip

com.ibm.dse.base.types

dseb.jar, DSEBase.zip

com.ibm.dse.base.types.ext

dsetde jar, DSETypedDataExtensions.zip
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Table 20. JAR, RAR or ZIP files for packages (continued)

Package name

JAR/RAR/ZIP name

com.ibm.dse.clientserver

dseb.jar, DSEBase.zip dsepsi jar,
DSEPresentationServerInfra.zip

com.ibm.dse.cs.servlet

dsecss.jar, DSEClientServerSupport.zip dsecsm jar,
DSEClientServerMechanism.zip dseb.jar, DSEBase.zip

com.ibm.dse.desktop

dsed jar, DSEDesktop.zip

com.ibm.dse.gui

dsegb.jar, DSEGuiBeans.zip

com.ibm.dse.jxfsds.wosamsd dsewomjxds.jar
com.ibm.dse jxfsds. wosaptr dsewopjxds.jar
com.ibm.dse.samples.landp DSELandpSample.zip
com.ibm.dse.samples.wosa DSEWosaSample.zip
com.ibm.dse.services dsesci.jar
com.ibm.dse.services.jxfs dsejxbsve jar

com.ibm.dse.services.jxfs.chk

dsejxcsve jar

com.ibm.dse.services.jxfs.ptr dsejxpsvc.jar
com.ibm.dse.services.landp dselansvc.jar
com.ibm.dse.services.wosa dsewossvc.jar
com.ibm.dse.sysmngment dsesym.jar
com.ibm.dse.wosabean dsewojxdsi.jar

Where to find the missing prerequisites

Use the following table to locate and obtain any missing prerequisites. Some of
them can be found in other JAR or ZIP files.

Table 21. Locations for prerequisites

Prerequisite Resource name How to get them

IBM DB2 db2java.zip Available from IBM DB2
Universal Database

Oracle classes12.zip Available from Oracle

SQL Server 2000 msutil jar mssqlserver.jar Available from Microsoft

msbase.jar SQL Server 2000

J2EE Connector Architecture |j2ee.jar Available in WebSphere

API Application Server

MQSeries® MQSeries.jar Available from MQSeries

Xerces Java Parser xerces.jar Available in WebSphere
Application Server

LANDP ldpjava.jar Available from LANDP.
Version 6.0 required

JavaHelp jh.jar Available in WebSphere
Application Server

SOAP soap.jar Available in WebSphere
Application Server

EJB Container ejbcontainer.jar Available in WebSphere
Application Server
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Table 21. Locations for prerequisites (continued)

Prerequisite Resource name How to get them
RAS/Trace Subsystem ras.jar Available in WebSphere
Application Server
Runtime Utilities utils jar Available in WebSphere
Application Server
External WebSphere APIs websphere.jar Available in WebSphere
Application Server
Xalan xalan.jar Available in WebSphere
Application Server
EJB base classes ivjejb35 jar Available in WebSphere
Application Server
Data converters vaprt.jar Available in WebSphere
Application Server
QName XML Extension gname.jar Available in WebSphere
Application Server
WSDL wsdl4j jar Available in WebSphere
Application Server
Portal PortalStruts.jar Available in WebSphere
PortalStrutsBase.jar Portal Server. Version 5.1
PortalStrutsCommon jar required
PortalStrutsTags.jar

portlet-api.jar strutsfilters.jar
StrutsUpdateForPortal jar

J2EE Connector Architecture
Default Connection Manager

cef2 jar

Available in WebSphere
Application Server

Web Services Invocation
Framework

wsif jar wsif-j2c.jar wsatlib.jar
wsif-compat.jar
wsif-compatb.jar

Available in WebSphere
Application Server

Work Area

acwa.jar distexcep.jar

Available in WebSphere
Business Integration Server
Foundition

BP Support

bpejar

Available in WebSphere
Business Integration Server
Foundition

Activity Session

activitySession.jar

Available in WebSphere
Application Server

Common Log

commons-logging-api.jar

Available in WebSphere
Application Server

Eclipse

compatibility;jar console jar
corejar defaultAdaptor.jar
eclipseAdaptorjar jface jar
osgijar resolverjar
runtime jar services.jar
servletjar swtjar uijar

util jar workbench.jar
xercesImpl.jar xml-apis.jar

Available in Eclipse, version
3.0.0 required.

xmlParserAPIs jar
JavaBeans™ Activation activation.jar Available in WebSphere
Framework Application Server
JavaMail mail jar Available in WebSphere

Application Server
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Table 21. Locations for prerequisites (continued)

Prerequisite

Resource name

How to get them

Runtime

runtime.jar

Available in WebSphere
Application Server
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Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM China Software Development Lab

2/F Deshi Building, No.9 Shangdi Dong Rd,
Beijing 100085, PR. China

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples may include
the names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

28  IBM Branch Transformation Toolkit for WebSphere Studio: Installation guide



Trademarks and service marks

The following terms are trademarks of International Business Machines
Corporation in the United States, or other countries, or both:

AIX MQSeries

AIX 5L pSeries

DB2 S/390 Parallel Enterprise Server
DB2 Universal Database WebSphere

eServer z/0S

IBM zSeries

LANDP

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.
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